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Use this guide for your first steps with the Agilent 6200 Series 
Time-of-Flight and 6500 Series Quadrupole Time-of-Flight LC/MS system, 
and as a road map for your user information.

What is the Agilent 6200 Series TOF LC/MS system?

The Agilent TOF is an orthogonal acceleration time-of-flight mass 
spectrometer (oa-TOF). The ions reaching the time-of-flight 
chamber are impelled in a direction perpendicular to their 
original path, meaning that the acceleration pulse applied to 
send the ions down the flight tube is orthogonal to the direction 
that ions are entering the mass analyzer. This geometry 
minimizes the effect of the entrance velocity on the flight time, 
leading to higher resolution.

You can set up an Agilent TOF LC/MS with the Agilent 1200 LC or 
1260 and 1290 Infinity modules and one of several ion interfaces: 
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What is the Agilent 6500 Series Q-TOF LC/MS system?
• ESI

• AJS ESI (Agilent Jet Stream ESI) 

• Dual ESI

• Dual AJS ESI (Dual Agilent Jet Stream ESI)

• MMI 

• APPI 

• APCI

• MALDI

• Nanospray

• Dual nanospray

• HPLC-Chip interface. 

The Agilent 6230 Accurate-Mass TOF also supports the Agilent Jet Stream ESI. 
The AJS ESI source utilizes a super-heated sheath gas to collimate the 
nebulizer spray which dramatically increases the number of ions that enter 
the mass spectrometer.

Each Agilent system has advantages for drug discovery — high throughput sample 
screening with highly sensitive detection and accurate mass assignment. 

What is the Agilent 6500 Series Q-TOF LC/MS system?

The Agilent Q-TOF LC/MS is a liquid chromatograph-quadrupole time-of-flight 
mass spectrometer that performs MS/MS using a quadrupole, a hexapole collision 
cell and a time-of-flight analyzer to produce spectra. The quadrupole selects 
precursor ions that are fragmented in the collision cell into product ions, which 
are then impelled to the detector, at an angle perpendicular to the original path. 

You can set up an Agilent Q-TOF LC/MS with the Agilent 1200 LC or 1260 and 
1290 Infinity modules and one of several ion interfaces: ESI, Dual ESI, APCI, APPI, 
multimode, MALDI, nanospray, dual nanospray or HPLC-Chip interface.

The Agilent 6538 and 6540 UHD Accurate-Mass Q-TOF also can be set up with the 
Agilent Jet Stream ESI source. This source utilizes a super-heated sheath gas to 
collimate the nebulizer spray which dramatically increases the number of ions 
that enter the mass spectrometer.
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What is the Agilent MassHunter Workstation Software?
What is the Agilent MassHunter Workstation Software?

The Agilent TOF and Q-TOF LC/MS comes with Agilent MassHunter Workstation 
Software that includes these programs:

• Data Acquisition – From one screen you can tune the mass spectrometer, 
control and monitor instrument parameters, set up methods containing 
acquisition parameters and worklists containing multiple samples and monitor 
real-time run plots.

• Qualitative Analysis – From one screen you can set up methods to extract and 
integrate chromatograms, extract peak spectra and compare data from 
different types of data files. More importantly, you can find compounds and 
generate formulas for those compounds. For more information on the 
Qualitative Analysis program, please refer to either the Qualitative Analysis 
Familiarization Guide or the online Help for the Qualitative Analysis program.

• Quantitative Analysis - From one screen you can set up a batch of data files and 
quantify, evaluate and requantify the results should you want to do this. For 
more information on the Quantitative Analysis program, please refer to either 
the Quantitative Analysis Familiarization Guide or the online Help for the 
Quantitative Analysis program.

• Report Designer Add-in - You can customize many of the reports that are used 
in the Qualitative Analysis program and the Quantitative Analysis program by 
using the Report Designer Add-in. Reports are created by using templates, 
Microsoft Excel and the Report Designer Add-in. For more information on the 
Report Designer Add-in, please refer to either the Reporting Training DVD or 
the online Help for the Report Designer Add-in. You cannot customize many of 
the reports in the Data Acquisition program.
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What’s New in B.04.00
What’s New in B.04.00

• The Agilent 6220, 6224 and 6230 Accurate-Mass TOF mass spectrometers are 
supported.

• The Agilent 6210A TOF mass spectrometer, if it is upgraded to a 6220A, is 
supported.

• The Agilent 6520A, 6520B and 6530A Accurate-Mass Q-TOF mass spectrometers 
are supported in this release.

• The Agilent 6538 and 6540 UHD Accurate-Mass Q-TOF mass spectrometers are 
supported.

• The Dual AJS ESI source is supported on the Agilent 6538 and Agilent 6540 
UHD Accurate-Mass Q-TOF mass spectrometers.

• The Dual AJS ESI source is supported on the Agilent 6230 UHD Accurate-Mass 
TOF mass spectrometer.

• Windows 7 is supported.

• Excel 2010 on Windows 7 is supported for printing Q-TOF and TOF tune 
reports.

• Reports for the Acquisition Method and the Worklist are printed using a 
different tool called RDL.

• When acquiring data in Auto MS/MS mode, you can specify a minimum purity.

• When acquiring data in Auto MS/MS mode, you can specify a target abundance 
and reject precursor ions that do not meet the target abundance.

• When acquiring data in Auto MS/MS mode, you can specify the isotope model.

• You can specify to use fixed collision energies, a Collision Energy table or a 
formula to determine the collision energy.

• Compliance for Data Acquisition is supported.

• The Study Manager program is supported. You can create a study from an 
existing worklist.

• The Map File Generator program supports Worklists, Drug Discovery Screening 
and Optimization Automation map files.

• The Method Comparator is now available.

• Method Audit Trail in Compliance mode and comparison of method versions is 
available when compliance is enabled.

• The worklist contains the Sample Group and Sample Info. columns that are 
displayed in Quant.

• Barcodes can be specified for plates in a worklist.

• Locked mode runs are supported in Study Manager.
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What’s New in B.04.00
• A standby script can be specified in Study Manager.

• Checksum for studies is supported.

• Needle Seat Back Flush using G4227A Flexible Cube is supported.

• The Carryover Reduction feature for the HPLC-Chip is supported.

• The Agilent 1260 Isocratic Pump (G1310B) is supported.

• The Agilent 1260 Quaternary Pump (G1311B) is supported.

• The Agilent 1260 Quaternary Pump VL (G1311C) is supported.

• The Agilent 1260 Capillary Pump (G1376A) is supported.

• The Agilent 1260 Nano Pump (G2226A) is supported.

• The Agilent 1260 Binary Pump (G1312B) is supported.

• The Agilent 1260 Binary Pump VL (G1312C) is supported.

• The Agilent 1290 Binary Pump VL (G4220B) is supported.

• The Agilent 1260 Standard Autosampler (G1329B) is supported.

• The Agilent 1260 High Performance Autosampler (G1367E) is supported.

• The Agilent 1260 Micro High Performance Autosampler (G1377A) is supported.

• The Agilent 1290 LC Injector HTC/HTS (G4277A) is supported.

• The Agilent 1290 LC Injector HTC/HTS (G4278A) is supported.

• The Agilent 1260 Variable Wavelength Detector VL (G1314B) is supported.

• The Agilent 1260 Variable Wavelength Detector SL (G1314C) is supported.

• The Agilent 1260 Variable Wavelength Detector (G1314F) is supported.

• The Agilent 1290 Variable Wavelength Detector (G1314E) is supported.

• The Agilent 1260 Diode Array Detector SL (G1315C) is supported.

• The Agilent 1260 Diode Array Detector VL (G1315D) is supported.

• The Agilent 1260 Diode Array Detector (G4212B) is supported.

• The Agilent 1260 TCC (Thermostatted Column Compartment) (G1316A) is 
supported.

For a list of updates made to previous versions, refer to online Help.
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Where to find information
Online Help
Where to find information 

Online Help

Press F1 To get more information about a pane or dialog box, place the cursor on 
the pane or dialog box of interest and press F1. 

Help menu From the Help menu, access “How-to” help and reference help. 

Documents

Some of these manuals are delivered with the TOF and Q-TOF LC/MS hardware or 
software. You can also find a PDF version of each manual on the installation disk, 
in the Manuals folder, and you can display several of these manuals from the online 
Help for the corresponding program.

You can find a PDF version of manuals for the offline or related MassHunter 
products on the installation disks for those programs. You can also access these 
manuals from the Getting Started section in the Online Help.

Installation Guide This guide is used by the Agilent customer engineer to install 
the hardware and software, configure the instrument, and verify performance. A 
different installation guide is available for the Q-TOF, the 6210/6220 TOF and the 
6224/6230 TOF.

Concepts Guide - The Big Picture Learn the background information to help you 
understand operation of the hardware and acquisition software.

TOF/Q-TOF Familiarization Guide Do the exercises to learn to use the TOF/Q-TOF 
LC/MS hardware and acquisition software.

Maintenance Guide Use this guide to help maintain and troubleshoot your 
Agilent TOF LC/MS or your Agilent Q-TOF LC/MS.

Study Manager Quick Start Guide Use this guide to learn to use the MassHunter 
Study Manager software.

MassHunter QQQ Compliance Quick Start Guide Use this guide to learn about the 
MassHunter QQQ Compliance program.
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Where to find information
Training
MassHunter Quant Compliance Quick Start Guide Use this guide to learn about 
the MassHunter Quant Compliance program. (This guide is on the Quantitative 
Analysis disk.)

Qualitative Analysis Familiarization Guide Do the exercises to learn to use the 
Qualitative Analysis program. (This guide is on the Qualitative Analysis disk.)

Quantitative Analysis Familiarization Guide Do the exercises to learn to use the 
Quantitative Analysis program. (This guide is on the Quantitative Analysis disk.)

Report Designer User Information DVD Learn how to customize the Excel 
templates that are used to create reports. The User Information DVD contains 
movies to show you how to customize a template and familiarization exercises to 
learn to do to learn to customize a template.

MassHunter BioConfirm Software Quick Start Guide Learn how to use the 
BioConfirm software (The Agilent MassHunter BioConfirm software can be 
purchased separately. This guide is included with the Agilent MassHunter 
BioConfirm software.)

MassHunter BioConfirm Familiarization Guide Do the exercises to learn how to 
use the BioConfirm software (The Agilent MassHunter BioConfirm software can 
be purchased separately. This guide is included with the Agilent MassHunter 
BioConfirm software.)

Training

Familiarization Guide Use all three familiarization guides (Data Acquisition, 
Qualitative Analysis and Quantitative Analysis) to get to know the software.

Quick Start Guide Use the quick start guides for Study Manager, Acquisition 
Compliance and Quantitative Analysis Compliance to get to know these programs.

Report Designer User Information DVD Watch the movies and use the 
familiarization guide to learn how to customize a report.

Training Courses Visit www.chem.agilent.com to view a listing of training courses 
for the Series 6200 TOF and the Series 6500 Q-TOF LC/MS.
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Getting Started
Getting Started

Install the TOF or Q-TOF LC/MS hardware and software

Use the Installation Guide for your instrument to install the hardware and 
software and verify performance. 

Set up, run and analyze samples

The roadmap below shows you the steps to set up and run a batch of samples from 
start to finish. Follow the instructions on the next pages to get started and to learn 
where to find the information to help you with each step in this roadmap.

Start 
Here!

Set up, run 
and analyze 

samples

3 Set up and 
run an 
acquisition 
method

1 Start the 
Data 
Acquisition 
software

2 Prepare the 
LC/MS

4 Review results 
and find 
compounds 
with Qual 
Analysis 

Set up and run 
quantitation 
(optional)
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Getting Started
Step 1. Start the Data Acquisition software
Step 1. Start the Data Acquisition software

The instructions below include the following assumptions:

• The hardware and software are installed.

• The instrument is configured.

• Use instructions in the Installation Guide to configure the instrument for 
the first time and any time you change the LC configuration.

• The LC modules and the LC/MS instrument are turned on, but the LC pump 
is not running.

After installation, you see all of the Agilent MassHunter Workstation software 
icons on your Desktop.

• To start the Data Acquisition program, double-click the Data Acquisition icon.

NOTE When Data Acquisition opens, the software engines automatically 
start. If you need to restart them, double-click the Acq System 
Launcher icon on your Desktop, and click Start.

Do not run start any MassHunter program as administrator.

If you have recently changed LC modules, remember to configure the 
instrument again. See the Installation Guide for instructions.
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Getting Started
Step 1. Start the Data Acquisition software
Four panes—where you do most of your work

When you first start the Data Acquisition software, the main window appears. You 
do almost all of your work within the four panes of this main window. These panes 
provide the tools to set up acquisition methods, run samples interactively or 
automatically, monitor instrument status and monitor runs.

Figure 1 Main window of the Data Acquisition software 

Show/hide the panes You can show one pane at a time on the screen or up to 
four panes. You can never hide all four panes. To show or hide a pane, you click the 
icons in the main window toolbar or you can use the menu items in the View 
menu.

When you click a pane, the active pane is outlined in blue. Press F1 to obtain help 
on the active pane. You can also drag a pane border to resize the pane.

Click a button to 
see the pane you 
want to use.

Instrument Status pane Real-time Plot pane Method Editor pane Worklist pane
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Getting Started
Step 1. Start the Data Acquisition software
Instrument Status pane With this pane you view the status of each module 
configured with the instrument–On, Off or Standby.

You also set non-method control and configuration parameters for the LC devices 
and MS and monitor the status of the device parameters during a run.

Real-time Plot pane With this pane you monitor the chromatogram and spectral 
plots in real time. 

S–Instrument Status; R–Real-time Plot
M–Method Editor; W–Worklist; T–Tune

Profile view of MSUser-defined signals and/or 
instrument parameters

Centroid spectrum display
Agilent 6200 Series TOF and 6500 Series Q-TOF LC/MS Quick Start Guide 11



Getting Started
Step 1. Start the Data Acquisition software
Method Editor pane With this pane you enter acquisition parameters for the 
method and sample information to run individual samples interactively.

Worklist pane With this pane you enter sample information for multiple samples. 
When you run the worklist, the samples are automatically run in the order listed in 
the worklist.
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Getting Started
Step 2. Prepare the LC modules
Step 2. Prepare the LC modules

Read and follow the instructions in the online Help for each of the tasks in the 
checklist described on the following pages.

1 Switch LC Stream to Waste.

While you condition or equilibrate the column, you can tune the TOF or Q-TOF 
MS. During this time you do not want pump effluent going into the TOF or 
Q-TOF MS, so you switch the direction of the LC stream away from the MS ion 
source and to waste.

If you have the LC connected to a VWD or DAD, you can still monitor the 
fluctuations of the VWD or DAD real-time chromatogram before a run.
a Make sure that the General tab in the MS TOF or MS Q-TOF tab is selected 

in the Method Editor pane.

b In the LC Stream (Seg) group box, click Waste.

c Click Apply.
2 Purge the LC pump.

Follow the directions for purging the pump in the User Guide for your pump.
3 Condition or equilibrate the column.
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Getting Started
Step 2. Prepare the LC modules
After you purge the pump, you set up to condition or equilibrate the column.
a Enter LC parameters, and click Apply to download them to the LC.

OR, to select an LC conditioning method, select one from the Method list at the 
top of the Data Acquisition window. or select one from the list that appears 
when you select File > Open > Method.

b Right-click an LC module in the Instrument Status pane to change any 
non-method control parameters, if necessary.

c Monitor the baseline and adjust the plot to make sure the column is 
equilibrated and the baseline stable. (See step 4 and step 5 on page 15.)
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Getting Started
Step 2. Prepare the LC modules
4 Set up to view real-time parameter values (actuals).

As you prepare for a run and during a run, you want to see the actual 
values of the instrument parameters. You can do this in the Instrument 
Status pane.
a Right-click the Actuals section in the Instrument Status pane to see the 

Setup menu item.

b Click Setup to bring up the list of Actuals available for monitoring. If 
you have configured a TOF instrument, the actuals for the TOF 
instrument are displayed instead.

c Add all the parameter values you intend to monitor, and click OK.
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Getting Started
Step 2. Prepare the LC modules
5 Set up real-time plot displays.

As you condition the column, you set up the displays to monitor the effluent.

• Right-click the chromatogram plot, and click Change.

In the Edit Signal Plot dialog box, you can select any type of display signal.
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Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
Step 3. Prepare the TOF and Q-TOF instrument

You need to tune the instrument the first time you use it or after maintenance, 
service or pump-down and restart. You do not need to tune often with standard 
use. Agilent does recommend that you calibrate the mass-axis regularly.

If you are installing the instrument, please refer to the Installation Guide for 
instructions on how to tune the instrument for the first time. The instructions 
below describe the entire tuning process for an instrument that has previously 
been tuned, starting with the Check Tune algorithm.

Before you run a Set Detector Gain, Standard Tune or Initial Tune, the 
Instrument Mode must be set to Extended Dynamic Range. After you run one of 
these autotunes, if you want to acquire data with a different Mass Range or 
Instrument Mode, change these values to the appropriate values for your analysis. 
If you change the values in the Instrument State tab after you finish the autotune, 
you must recalibrate the TOF or Q-TOF. If you change the mass range, you must 
recalibrate the instrument.

You can only run Initial Tune, Standard Tune, Set Detector Gain, Quad Tune or 
Initial Quad Tune with a source is supported for all Autotunes and if the 
Instrument Mode is Extended Dynamic Range. These buttons are grayed out if a 
different Instrument Mode is selected, or if a different source is installed.

Table 1 Supported sources for all Autotunes

Instrument Model Number Supported Sources for All Autotunes

6220 TOF ESI, Dual ESI

6230/6224 TOF Dual ESI, AJS ESI, Dual AJS ESI

6520 Dual ESI

6530 Dual ESI, AJS ESI, Dual AJS ESI

6540/38 Dual ESI
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Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
For All Agilent 6200 Series TOF and 6500 Series Q-TOF

You can do a Check Tune, Quick Tune and Check Quad Tune with all instrument 
states and the following sources: 

• ESI 

• AJS ESI (Agilent Jet Stream ESI)

• Dual ESI

• Dual AJS ESI (Dual Agilent Jet Stream ESI)

• MMI 

• APPI 

• APCI 

You cannot do any of the automated tunes if the source is a nanoESI, a Dual 
nanoESI, an HPLC-Chip or a MALDI source.

If Fast Polarity Switching is Enabled, you cannot run any of the Quad Autotune 
algorithms.

Diluting the ESI-L Tune Mix

If your instrument is an Agilent 6540A or 6530A with either an Agilent Jet Stream 
ESI source or a Dual AJS ESI source, autotune can fail unless you dilute the tuning 
mix.

For other models, you may need to dilute the tuning mix under certain conditions. 
When tuning in negative ion polarity, dilute the tuning mix to calibrate properly. 
When tuning in positive ion polarity, dilute the tuning mix if you are not getting 
proper calibraiton. The instructions for diluting the tuning mix are included in the 
Installation Guide and in the online Help.

Tune the TOF and Q-TOF MS 

1 In the Context list, select Tune.

The Tune pane appears in place of the Method pane and the Worklist pane in 
the Data Acquisition window. Note that you tune the TOF separately from the 
quadrupole.
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Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
Initial autotunes are appropriate for initial system installations, after 
removal/replacement of ion optics or mass analyzer components, or if standard 
tunes cannot complete successfully.

If the software was just installed, and an autotune was completed as described 
in the Installation Guide, skip to “Switch LC stream to MS” on page 26.

Figure 2 Autotune tab for an Agilent 6538/6540 Series Q-TOF

The Quadrupole section is only available if you have configured a Q-TOF 
instrument.

2 (optional) Click the Preferences tab.
3 (optional) Mark whether or not you want the system to automatically adjust the 

abundance of the calibrant ions. 

This is an advanced feature, and you probably do not need to change this 
setting.

If you mark the Adjust the abundance for optimal calibration check box, the 
system automatically adjusts the fragmentor voltage to reduce the abundance 
for calibration masses if the calibration masses are detected to be out of the 50 
to 650K range. If the fragmentor voltage cannot be adjusted low enough to cause 
the abundance level to fall below 650K, the system tells you to dilute the 
calibrant and then to try the calibration or autotune again.

4 Click the Autotune tab.
5 Mark the polarity to use when tuning under TOF on the Autotune tab. You can 

mark Positive, Negative or both. For some instruments, you can also mark Fast 
Polarity Switching. If you mark the Fast Polarity Switching check box, then 
four different autotunes are done.

• Positive
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Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
• Negative

• Fast Polarity Switching Positive

• Fast Polarity Switching Negative

Figure 3 Autotune tab for an Agilent 6200 Series Time-of-Flight

6 (optional) Mark the Pause Between Autotunes (for Calibration Solution 
Swapping) check box if you use a different calibration solution for positive and 
negative autotunes. 

7 Click Check Tune to check the TOF mass calibration and optimization. Then, 
click Start Autotune (Check Tune takes 3 to 5 minutes to complete).

If the system pauses between autotune to allow you to change calibration 
solutions, change the tuning mix to one diluted for the next tune as described in 
the online Help and in the Installation Guide.

You repeat Check Tune after you dilute the calibration solution if the 
abundances are greater than 480,000 for any of the calibrating ions for the 
6538/6540 Q-TOFor above approximately 750,000 for other Q-TOF and TOF 
instruments.

If Check Tune results are acceptable, then you can skip to step 12 if you have a 
Q-TOF instrument or to “Switch LC stream to MS” on page 26 if you have a TOF 
instrument.

If Checktune results are not acceptable, then continue with step 8.
8 Click Quick Tune to use a limited set of parameters to tune the MS 

automatically. Then, click Start Autotune (Quick Tune takes 7 to 10 minutes to 
complete). 
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Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
If the system pauses between autotune to allow you to change calibration 
solutions, change the tuning mix to one diluted for the next tune as described in 
the online Help and in the Installation Guide.

You repeat Quick Tune after you dilute the calibration solution if the 
abundances are greater than 480,000 for any of the calibrating ions for the 
6538/6540 Q-TOFor above approximately 750,000 for other Q-TOF and TOF 
instruments.

If Quick Tune results are acceptable, then you can skip to step 12 if you have a 
Q-TOF instrument or to “Switch LC stream to MS” on page 26 if you have a TOF 
instrument.

If Quick Tune results are not acceptable, then continue with step 9.
9 Run a Standard Tune to use even more parameters (10 to 15 minutes):

a Click the Instrument State tab. 

b For the Instrument Mode, click Extended Dynamic Range.

c (optional) Mark or clear the Fast Polarity Switching check box.

d Click Apply.

e Click the Autotune tab.

f Mark the polarity (polarities) to use when tuning under TOF on the 
Autotune tab.

g Click Standard Tune.

h Click Start Autotune.

Use a source that is supported for all Autotunes when running a Standard 
Tune. The Dual ESI source is supported for all Autotunes for all instruments. 
Refer to “Supported sources for all Autotunes” on page 17 for a complete list of 
sources that are supported for all Autotunes.

If the system pauses between autotune to allow you to change calibration 
solutions, change the tuning mix to one diluted for the next tune as described in 
the online Help and in the Installation Guide. If Standard Tune results are 
acceptable, continue with step 10.

If Standard Tune produces unacceptable results you can do an Initial Tune. If 
this also fails to give acceptable results, please contact Agilent Field Support.

Instrument Time for Initial Tune (TOF)

Agilent 6538A and 6540A Q-TOF up to 60 minutes for each polarity

Other Q-TOF instruments and TOF instruments up to 30 minutes for each polarity
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Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
If you want use custom tune parameter values, you can also do a Manual Tune.

10 Set the Mass Range and the Instrument Mode that you want to use to acquire 
data. 
a Click the Instrument State tab.

b Select the appropriate Mass Range.

c Click the appropriate Instrument Mode.

d Click Apply.
11 Recalibrate, if necessary.

Calibration is done when you click the Check Tune button, the Quick Tune 
button, the Standard Tune button and the Initial Tune button. If you just 
completed one of these tasks, and if any of the following are true, you only need 
to recalibrate:

• You change the Instrument Mode in the Instrument State tab.

• You change the Mass Range in the Instrument State tab.

• The peak abundances are above approximately 480,000 for the 6538/6540 
Q-TOF or above approximately 750,000 for other Q-TOF and TOF 
instruments. You have to dilute the tune calibrant before you recalibrate. You 
recalibrate to get optimal mass accuracy.

a Click the TOF Mass Calibration tab.

b Click the desired polarity in the top left corner of the Tune pane.

c To select a different set of masses, click Load or select or clear individual 
masses in the list on the left side of the Tune pane.

d Click the Calibrate button.

e If you want to calibrate the TOF analyzer in the opposite polarity, repeat 
step b through step d.

If you have a TOF instrument, skip to “Calibrate the mass-axis” on page 25.
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Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
12 If you have a Q-TOF instrument, check the options on the Instrument State tab 
before you tune the quadrupole.

If Fast Polarity Switching is Enabled, you disable it before you run any of the 
Quad Autotune algorithms. After the Quad tune results are acceptable, you will 
enable Fast Polarity Switching again and then recalibrate the TOF analyzer.
a Click the Instrument State tab.

b Select the appropriate Mass Range.

c Click the appropriate Instrument Mode.

d Select Disabled for Fast Polarity Switching.

e If you did not make any changes, skip to step 13.

f Click Apply.

g Click the TOF Mass Calibration tab.

h Click the desired polarity in the top left corner of the Tune pane.

i To select a different set of masses, click Load or select or clear individual 
masses in the list on the left side of the Tune pane.

j Click the Calibrate button.

k If you want to calibrate the TOF analyzer in the opposite polarity, repeat 
step h through step j.

l Click the Autotune tab.
13 Run the Check Quad Tune algorithm to check quadrupole optimization (2 to 5 

minutes).
a Click the Autotune tab.

b Click the Check Quad Tune button.

If the Check Quad Tune results are acceptable, then skip to step 16.

If Checktune results are not acceptable, then continue with step 14.
14 Run the Quad Tune algorithm to optimize the quadrupole using all its 

parameters (10 to 15 minutes).

The source that is used must be supported for all Autotunes when running a 
Quad Tune. The Dual ESI source is supported for all Autotunes for all 
instruments. Refer to “Supported sources for all Autotunes” on page 17 for a 
complete list of sources that are supported for all Autotunes.
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Also, you cannot run a Quad Tune if Fast Polarity Switching is Enabled. 
a Click the Instrument State tab. 

b For the Instrument Mode, click Extended Dynamic Range.

c Click Apply.

d Click the Autotune tab.

e Clear the Fast Polarity Switching check box.

f Click Quad Tune.

If Quad Tune produces unacceptable results you can do an Initial Quad Tune 
(50 to 60 minutes). If this also fails to give acceptable results, please contact 
Agilent Field Support.

If you would like to use custom tune parameter values, you can also do a 
Manual Tune.

15 Set the Mass Range and the Instrument Mode that you want to use to acquire 
data. 
a Click the Instrument State tab.

b Select the appropriate Mass Range.

c Click the appropriate Instrument Mode.

d Click Apply.
16 If you want to use Fast Polarity Switching, enable Fast Polarity Switching on 

the Instrument State tab and recalibrate.

If you have a Q-TOF instrument, Fast Polarity Switching was disabled before 
tuning the quadrupole. Follow these steps to enable Fast Polarity Switching:
a Click the Instrument State tab.

b Select Enabled for the Fast Polarity Switching.

c Click the appropriate Instrument Mode. 

d Click Apply.

e Wait 20 minutes for the instrument to equilibrate.

f Click the TOF Mass Calibration tab.

g Click the desired polarity in the top left corner of the Tune pane.

h To select a different set of masses, click Load or select or clear individual 
masses in the list on the left side of the Tune pane.

i Click the Calibrate button.

j If you want to calibrate the TOF analyzer in the opposite polarity, repeat 
step g through step i.

Tune reports are automatically generated at the end of a tune.
24 Agilent 6200 Series TOF and 6500 Series Q-TOF LC/MS Quick Start Guide



Getting Started
Step 3. Prepare the TOF and Q-TOF instrument
See the Concepts Guide for more information on the TOF and Q-TOF MS 
instruments.

Calibrate the mass-axis

During calibration, a sample that contains known masses is infused into the 
source, and the actual flight times for ions of known masses are measured. These 
times and exact masses are used to calculate updated calibration coefficients. This 
process ensures accurate mass assignments for unknowns. Agilent recommends 
that you do this regularly.

Calibration is done when you click the Check Tune button, the Quick Tune 
button, the Standard Tune button and the Initial Tune button. If you just 
completed one of these tasks, and if any of the following are true, you only need to 
recalibrate:

• You change the Instrument Mode in the Instrument State tab.

• You change the Mass Range in the Instrument State tab.

• The peak abundances are above approximately 480,000 for the 6538/6540 
Q-TOF or above approximately 750,000 for other Q-TOF and TOF 
instruments. You have to dilute the tune calibrant before you recalibrate. You 
recalibrate to get optimal mass accuracy.

1 In the Combo Bar, select Tune in the Context combo box.
2 Click the TOF Mass Calibration tab.

3 Select the Ion Source and Polarity on the left side of the Tune pane.
4 To select a different set of masses, click Load or select or clear individual 

masses in the list on the left side of the Tune pane.
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5 Click Calibrate.

The TOF or Q-TOF Calibration Results dialog box opens.
6 (optional) Repeat step 3 to step 5 for the other polarity.
7 Click Apply to apply the updated calibration coefficients.

Switch LC stream to MS

After you condition the column and tune the TOF or Q-TOF MS, you switch the LC 
stream from Waste to MS.

a In the Context list, click Acquisition.

b Make sure that the General tab in the MS TOF or MS Q-TOF tab is selected 
in the Method Editor pane.

c In the LC Stream (Seg) group box, click MS.

d Click Apply.

Monitor MS baseline and spectral displays

• If you did not monitor the LC baseline with a VWD or DAD, make sure that the 
TOF or Q-TOF baseline is stable and no spectra of interfering intensity appear.

• If you did monitor the LC baseline with a VWD or DAD, change back to the 
default TOF or Q-TOF displays.
a Right-click the chromatogram plot, and click Change.

b Select the MS signal, and click OK.

View the system logbook for events and errors

As you prepare the instrument, you may run into an error that you want to 
troubleshoot. You do this through the System Logbook Viewer.

• Click the Log icon in the toolbar of the Data Acquisition window, and view the 
logged events. 

• Or right-click the  icon in the system taskbar. First, click Enable 
Notification. Then, right-click the LOG icon and click Configure. The system 
can notify you of new errors and warning by showing messages from the 
taskbar.
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Step 4. Set up and run a method

An Agilent MassHunter Workstation software method for TOF and Q-TOF can 
contain acquisition parameters, qualitative analysis parameters or both. 

When you run a single sample or multiple samples in a worklist with this .m 
method, you can specify whether to run both data acquisition and data analysis or 
to only run either data acquisition or data analysis.

If you select to run both data acquisition and data analysis, then data analysis will 
automatically follow acquisition if qualitative analysis parameters are also 
contained in the method. You can also run a method to produce only raw data 
(acquisition only) or reprocess the data with a method containing only qualitative 
analysis parameters (data analysis only).

In this step you learn how to set up the method with acquisition parameters only, 
with qualitative analysis parameters only and with a combination of acquisition 
parameters and qualitative analysis parameters. 

Read and follow the instructions in the online Help for each of the tasks described 
on the following pages.

Set up a method with acquisition parameters

Do Exercise 1 and Exercise 2 of the TOF/Q-TOF Familiarization Guide to learn 
how to set up and run a method with only acquisition parameters. 

Before editing or running a method, set the options in the Instrument State tab in 
the Tune pane. 

• Type the values and settings for each of the tabs below.

• (optional) If you want to download the settings to the instrument, click 
Apply.

• To save the method after entering parameters, click File > Save As > 
Method.

• Type the name for the method in the Method field, and click the OK button.
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1 In the Context list, click Acquisition.
2 Enter LC parameter values.

Type the values for all of the LC modules configured for the instrument.

3 Set up to change TOF and Q-TOF MS parameters with segments and 
experiments:
a Click the MS TOF or MS Q-TOF tab in the Method Editor.

b To add a segment, right-click the Time Segment section and click Add Row.

The time segment will use those parameter entries with (seg) next to their 
names. Those parameters can be changed for each time segment.

c To add an experiment, right-click the Experiment section, and click Add 
Row. The experiment will use those parameter entries with (Expt) next to 
their names. Those parameters can be changed for each experiment.
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d Enter the parameters for each segment and experiment. When you add a 
new time segment, the parameters for the time segment that is selected are 
used as the default values for the new time segment. When you add a new 
experiment, the parameters for the last experiment in the list are used as 
the default values for the new experiment.

See Chapter 3 of the Concepts Guide for an explanation of how and why you 
use time segments and experiments.

4 Enter TOF or Q-TOF MS parameter values:
a Click the General tab, and enter any General parameters that you want to 

change.

b Click the Source tab, and enter any Source values you want to change.

c Click the Acquisition tab.

d Select the mode of operation for the Q-TOF LC/MS: MS mode, Auto MS/MS 
mode or Targeted MS/MS mode. If you have a TOF configured, you can 
only use MS mode.
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Different parameters are made available depending on the mode selected.

To learn more about these parameters and how they affect results, refer to 
Chapter 3 of the Concepts Guide or the online Help.

e Enter any values you want to change in the Acquisition tab.

f Click the Ref Mass tab to set up the mass calibration.

g Click the Chromatogram tab to set up the chromatograms to plot during a 
run.

5 Set up a method with both acquisition and qualitative analysis parameters.

You can create either part of the method first.

If you want to add acquisition parameters to a method with Qualitative 
Analysis parameters:
a Set up a method with acquisition parameters.

b Click File > Save As > Method.

c Type the name of an existing method that contains Qualitative Analysis 
parameters.

d Click OK.

The method now contains both acquisition and Qualitative Analysis 
parameters.

NOTE The name of the method that contains only qualitative analysis parameters will not appear 
in the Name list in the Save Method As dialog box. Type the method name in the Method 
field and select the directory that contains that method in the Directory list.
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If you want to add qualitative analysis parameters to a method with acquisition 
parameters:
a Set up and save a method with acquisition parameters.

b Open the Qualitative Analysis program.

c Open a data file that was created with the acquisition method you set up 
and saved in step a.

d Enter the qualitative analysis parameters and change settings to meet your 
needs.

e Save the method using the same name that you used to save the method in 
step a.

The method now contains both acquisition and qualitative analysis parameters.

See the online Help to learn how to enter or change parameters and set up tasks 
for this method.

Set up and run interactive samples

1 Type the sample name, data file name and path.

2 To start the run, click the single sample icon, .

You can run the single sample in either locked or unlocked mode. When the 
mode is locked, no one can change the method or sample parameters during a 
run.
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Set up and run worklists 

1 Right-click the upper left corner of the worklist to display the following menu.

2 Click Add Multiple Samples.
3 Enter all relevant information, and click the Sample Position tab to specify the 

sample vial locations (make sure the specific sample tray type has been 
configured by right-clicking the autosampler device image).

4 Specify the locations, and click OK.
5 To set up the worklist run, right-click the upper left corner, and click Worklist 

Run Parameters.
6 Type the paths for the method, the Override DA method, and the data files, and 

click OK.
7 To start the run, click the Start Worklist run icon, .

You can run the worklist in either locked or unlocked mode. When the mode is 
locked, no one can change the method or the worklist while the worklist is 
running.

NOTE To use qualitative analysis parameters that are different than those contained in the 
method entered in the worklist, show the column called Override DA Method in the 
worklist by using the Show/Hide/Order Columns dialog box.

In this column, type the name of another method containing the qualitative analysis 
parameters you want to use for the sample. 

You can also type this method in the Add Multiple Samples dialog box.
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Step 5. Review results and find compounds with Qualitative Analysis 

• Use the Qualitative Analysis program to do these steps and more:

• Review results for acquisition method development

• Find compounds

• Identify compounds

• Do molecular feature extraction

• Export results

• Print reports

Refer to the online Help and do the exercises in the Qualitative Analysis 
Familiarization Guide to help you learn how to use the Qualitative Analysis 
program to do these tasks.

Step 6. Set up and run quantitation 

• If you want to quantitate your data, use the Quantitative Analysis program. 

Refer to the online Help and to the Quantitative Analysis Familiarization Guide 
to learn how to do more steps to analyze your data.
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